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Chapter 1  Introduction 

 
 
 
Overview 
 
The SuperLink Rx (SL Rx) is a highly selective and sensitive RF filter used in the receive path of 
wireless base stations. The SL Rx eliminates the trade-off between selectivity and sensitivity. 
The superior performance of the SL Rx enables wireless service providers to enhance customer 
satisfaction and increase their subscriber base by improving the quality of voice and data 
transmissions of their networks.  
 
Some advantages of incorporating a SL Rx in a wireless telecommunications network include: 
 
� Improved receiver noise figure 
� Improved out-of-band signal rejection 
� Stable sensitivity (cellular site performance not impacted by out-of-band interference) 
� Low power consumption 
� Virtually maintenance free operation 
� Convenient base station installation 
� Worry-free uplink enhancement 

 
 
About this Manual 
 
The SuperLink Rx Operation and Installation manual describes the 2-Pak and 6-Pak SL Rx. In 
addition, this manual describes the overlay model for the 2-Pak and 6-Pak SL Rx. Detailed 
information such as installation requirements, testing procedures, and troubleshooting tips will 
assist you with the proper installation and operation of the SL Rx.  
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Review the manual carefully for proper installation and operation of your SL Rx system. The 
following summary provides brief information about the chapters and appendices. 
 

Chapter Title Description 
   
1 Introduction States the purpose of the manual. Provides general information about 

the manual that you need to know. 
   
2 Using the SuperLink 

Rx 
Describes the role of the SL Rx in a typical wireless system. Provides 
information on SL Rx equipment configurations and functional 
descriptions. 

   
3 Unpacking the 

SuperLink Rx 
Provides detailed information about unpacking the SL Rx. 

   
4 Installation 

Requirements 
Lists the tools, materials, and test equipment requirements for SL Rx 
installation. 

   
5 Installing the 

SuperLink Rx 
Provides the following information for installing the SL Rx: installing 
the software programs, mounting the system, connecting the power and 
alarm wires, performing power up/cooldown, performing functional 
checks, and connecting RF cables. 

   
6 Troubleshooting Tips Provides basic troubleshooting procedures for problems that may occur 

during installation and operation. 
   
7 Periodic Visual 

Inspection 
Provides information about inspecting the SL Rx on a periodic basis. 

   
Appendix A Using the System 

Status Portal 
Explains the STI System Status Portal interface. 

   
Appendix B SuperLink Rx 

Specifications 
Provides detailed information about the SL Rx specifications. 

   
Appendix C Receive Path Gain/Loss 

Calculator 
Provides a table to record channel gain/loss values as you conduct the 
Receive Path Gain test. This Appendix is also available as a 
Microsoft® Excel file in the SuperLink Rx Operation and 
Installation Manual folder located on the STI CD. 
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General Safety 
 
Warnings, Cautions, and Notes 
 
Warnings, cautions, and notes are used throughout the manual. Review the significance of each: 
 

 
A warning denotes a hazard to personnel. A warning calls attention to a 
procedure, which if not correctly performed or adhered to, could result in injury 
to personnel. 

 

 

A caution denotes a hazard to equipment. A caution calls attention to a 
procedure, which if not correctly performed or adhered to, could result in 
damage to the equipment 

 

 
A note calls attention to a procedure for informational purposes only. 

 
Electrostatic Discharge 
 
The SL Rx contains components that are subject to damage from electrostatic discharge (ESD). 
Improper handling of the RF connectors, located on the rear panel of the SL Rx chassis, can 
result in ESD damage. Ensure that you adhere to all appropriate ESD precautions when handling 
components mounted at the rear of the system. The following caution appears throughout the 
manual during procedures in which the SL Rx may be subject to damage by ESD. 
 

 

The SL Rx contains components that are subject to damage from electrostatic 
discharge (ESD). Take precautionary measures when handling components 
mounted at the rear of the equipment. 

 
 
Technical Assistance 
 
For technical assistance, call the STI Customer Service Hotline (CS-Hotline):  800.727.3648. 
 

 
“CS-Hotline” refers to the STI Customer Service Hotline. For your convenience, 
the CS-Hotline number is located on the bottom of each page throughout the 
manual. 
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Warranty 
 
On a standard basis, Superconductor Technologies Inc. (STI) warrants its SuperLink 
Rx to be free from any defect in material and workmanship for a period of one (1) 
year from the date of shipment. 
 
STI’s sole obligation under this warranty is to repair or replace the SuperLink Rx or 
any part thereof, which proves to be defective after inspection by STI. The warranty 
for the repaired or replaced SuperLink Rx is the un-expired warranty period of the 
original SuperLink Rx, or ninety (90) days whichever is greater. This warranty does 
not apply to any SuperLink Rx that has been disassembled, modified, subjected to 
unusual electrical or physical stress, misuse, neglect, excessive deterioration or 
erosion, abuse, accident, unauthorized repair, improper installation, or use in any 
way that is contrary to the instructions set forth herein. 
 
STI is not liable for any indirect, incidental, consequential or special damages, 
including without limitation, lost profits and cost of procurement of substitute goods.
 
This warranty is the full extent of obligation and liability assumed by STI with 
respect to its SuperLink Rx. STI neither assumes nor authorizes any other person to 
assume for it any other obligations or liability in connection with the sale, 
installation or use of its SuperLink Rx. 
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Chapter 2  Using the SuperLink Rx 

 
 
 
Equipment Configurations 
 
The SL Rx is available in United States A and B Cellular Frequency Bands. Both A-Band and  
B-Band SL Rx systems are available in 2-Pak and 6-Pak RF receiver configurations: 
 
� The 2-Pak SL Rx system provides two RF receive paths, and operates in a cellular system 

that uses omni-directional antennas, one main, and one diversity.  
� The 6-Pak SL Rx system is designed for a cellular system that uses three antenna sectors, 

each consisting of one main and one diversity antenna.  
 
Two RF configurations are available for both 2-Pak and 6-Pak SL Rx systems: 
 
� Cascade option  
� Variable Gain option (VGO) 

 
Additionally, the SL Rx system is configurable as an Overlay. See the “Overlay Model” section 
on page 6 for more information. 
 
F  

igure 1 shows a typical wireless telecommunications base station diagram with a SL Rx system. 

Note:  Single RF path shown for simplicity.

Base Station
Receiving Equipment

BASE STATION RECEIVE ANTENNA -
Receives RF signals from Wireless Network
Subscribers.

SUPERLINK Rx - Enhances the
performance of the Base Station
Receiver.

ANTENNA CABLE -
Conducts received RF
signals to the Base Station
Receiving Equipment via
the SuperLink Rx.

BASE STATION RECEIVING
EQUIPMENT - Processes
received RF signals in normal
manner.

4

4

WIRELESS NETWORK
SUBSCRIBERS

SuperLink Rx

Figure 1. Typical Base Station Diagram for the SuperLink Rx, Cascade Option 
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Cascade Option 
 
The SL Rx system is a Filter-Amplifier that connects in-line (cascade) with the existing receiver 
equipment. Figure 2 shows a Cascade system connected with a base station sector. The block 
diagram shows the Bypass RF path, which provides pre-SL Rx performance if the Filter-
Amplifier should develop a problem. The Filter-Amplifier connects directly to the antenna cable, 
and provides a clear, low noise signal to the receiver. 
 

Note:  Single RF path shown for simplicity.

Cryogenic RF Enclosure (CoRE)

Bypass
Relay

Bypass
Relay

Filter and Amplifier

LNA

Base Station
Receiver
Front-End
Filter/LNA

Power
Divider

Antenna

SuperLink Rx

Figure 2. Signal Flow Block Diagram, Cascade 

 
Overlay Model 
 
The Overlay model solves the problem of adding a new base station to an existing base station. 
This SL Rx system simplifies an overlay without degrading or interfering with the incumbent 
base station, in addition to providing SL Rx benefits to both technologies. To achieve maximum 
performance, the Overlay model uses a power divider that provides two separate outputs for 
every input as shown in Figure 3. Each path provides a modest positive gain and improvement in 
noise figure. Figure 3 shows an example of a system integration block diagram for one sector of 
a base station (Nortel Metro Cell (CDMA) and Nortel NT800 (TDMA)). 
 
Benefits of using the Overlay model include: 
 

� Only one SL Rx system is required for each sectored site. 
� Noise figure improvement. 
� Enhanced interference protection. 
� Sensitivity improvement for both new and existing base stations.  
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Figure 3. System Integration Block Diagram, Overlay Model 

 
Functional Description 
 
The functional areas of the SL Rx are described in the following paragraphs. See Figure 4 for a 
functional block diagram of the SL Rx. 
 
RF Signal Flow 
 
RF signals from the Antenna are connected to the Cryogenic RF Enclosure (CoRE). Inside the 
CoRE the signals connect to the first Bypass Relay. In normal operation the signals are 
connected to the band-specific superconducting filter and a Low Noise Amplifier (LNA) for each 
RF path. From the LNA, the signals go to the second Bypass Relay and then out of the CoRE to 
the connector panel on the rear of the SL Rx. 
 
If a problem develops during normal operation, such as the CoRE dropping out of the operating 
temperature, or a loss of power, the system will automatically switch into Bypass mode. In 
Bypass mode, the RF signals from the Antenna are routed through the initial RF Bypass Relay, 
bypassing the SL Rx Filter-Amplifier and into the second RF Bypass Relay. For SL Rx systems, 
in both SuperLink and Bypass modes of operation, the RF signals from the second RF Bypass 
Relay and are routed to the base station receiver. 
 
The SL Rx is set to Bypass mode on power up. In Bypass mode, both Bypass Relays switch 
together and connect the input to the output through a stripline circuit that bypasses the filter and 
LNA. The SL Rx system will automatically switch to SuperLink mode (Regulate state) when the 
CoRE has reached operating temperature. In SuperLink mode (Regulate state), the CoRE circuits 
provide highly selective filtering along with ~13 dB gain in each RF path. 
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Control 
 
The Digital Signal Processor (DSP) provides the SL Rx control and performance monitoring 
function. The DSP monitors:   
 
� Input voltage from the Power Supply 
� Driver power for the Cooling Motor Driver 
� CoRE temperature from the Thermal Sensor Interface 
� LNA current 

 
If input voltage drops or rises to an unacceptable level the DSP will cause the SL Rx to switch 
into the Fault Bypass mode and, at the same time, activate the alarm relay. Signals from the 
alarm relay are available for connection to a base station alarm system. The BYPASS LED, 
located on the SL Rx front panel, will illuminate RED (flashing or steady) to indicate Bypass 
mode. 
 
The DSP senses variations in driver current. If the motor driver current levels move to an 
unacceptable level the DSP will cause the SL Rx to switch into the Shutdown mode and, at the 
same time, activate the alarm relay as previously mentioned. 
 
The DSP controls the temperature of the CoRE. The Thermal Sensor Interface routes 
multiplexed sensor signals to the DSP. Correction signals are sent to the Cooling Motor Driver. 
If temperature levels move to an unacceptable level the DSP will cause the SL Rx to switch into 
the Bypass mode. Additionally, the DSP monitors the LNA current. Unacceptable levels of LNA 
current are sensed via the Power Supply and will cause the SL Rx to switch to Bypass mode. 
Each time the SL Rx is switched to Bypass mode, the alarm relay is activated. 
 
Cryogenic Cooling 
 
The STI Stirling Cycle Cryogenic Cooler is a highly efficient state-of-the-art Cryogenic Cooler. 
The Cryogenic Cooler maintains the CoRE at an operating temperature of ~78 K (Kelvin). The 
compressor and cold finger are fully integrated into a single self-contained unit. The Cooling 
Motor Driver provides drive and control to maintain a constant temperature. Temperature 
sensors in both the CoRE and the STI Stirling Cycle Cryogenic Cooler provide for constant 
temperature monitoring of the system by the Thermal Sensor Interface. 
 
Power 
 
27 VDC input power is received at the POWER terminal block connections, located on the rear 
panel of the SL Rx. DC power is routed through a 10-amp fuse to the fan and the power supply. 
The fan provides cooling air for SL Rx components installed outside the CoRE. The power 
supply routes regulated DC power to all SL Rx assemblies. 
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Figure 4. Functional Block Diagram 
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Indicators, Connectors, and Controls 
 
Front View of the SuperLink Rx 
 
The SL Rx provides two indicators, or LEDs, and one control on the front panel as shown in 
Figure 5 and described in Table 1. 
 

 

 

Figure 5. Front Panel Indicators 

 
Table 1. Front Panel Indicators and Controls 

Item No. Item Description 
1 STATUS LED Illuminates GREEN when the SL Rx is in S

(Regulate state). 
2 BYPASS LED Illuminates RED when the SL Rx is in Byp
3 FORCED BYPASS button Places the system in Forced Bypass mode w

button. The LEDs flash in Forced Bypass m
 

 
For more information about the LEDs, see Table 7. 

 
Rear Panel of the SuperLink Rx 
 
The rear panel contains signal and power connectors. The following figures s
rear panel views: 
 
� Figure 6 shows a 2-Pak SL Rx system 
� Figure 7 shows a 6-Pak SL Rx system 
� Figure 8 shows a 2-Pak SL Rx system, Overlay 
� Figure 9 shows a 6-Pak SL Rx system, Overlay 

 
Table 2 describes the controls and connectors located on the rear panel. 
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1 LNA OUT

ALARM

+ - NO   C   NCFUSE CONSOLE GND
27 VDC IN

1 FILTER IN 2 FILTER IN

2 LNA OUT

AUX

8

7

2 3 4 5 61

Figure 6. 2-Pak Rear Panel Connectors and Controls 

 
 

1 LNA OUT

ALARM
+ - NO   C   NCFUSE CONSOLE GND

27 VDC IN

1 FILTER IN 2 FILTER IN 3 FILTER IN 4 FILTER IN 5 FILTER IN 6 FILTER IN

2 LNA OUT 3 LNA OUT 4 LNA OUT 5 LNA OUT 6 LNA OUT

AUX

8

7

2 3 4 5 61

Figure 7. 6-Pak Rear Panel Connectors and Controls 
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1A LNA OUT

ALARM

+ - NO   C   NCFUSE CONSOLE GND

27 VDC IN

1B LNA OUT 2B LNA OUT
2A LNA OUT

AUX

8A

7

2 3 4 5 61

2 FILTER IN1 FILTER IN

8B

 
Figure 8. 2-Pak Rear Panel Connectors and Controls, Overlay 

 
 
 

1A LNA OUT

ALARM

+ - NO   C   NCFUSE CONSOLE GND
27 VDC IN

1B LNA OUT 2B LNA OUT 3B LNA OUT 4B LNA OUT 5B LNA OUT 6B LNA OUT
2A LNA OUT 3A LNA OUT 4A LNA OUT 5A LNA OUT 6A LNA OUT

AUX

8A

7

2 3 4 5 61

1 FILTER IN 2 FILTER IN 3 FILTER IN 4 FILTER IN 5 FILTER IN 6 FILTER IN

8B

Figure 9. 6-Pak Rear Panel Connectors and Controls, Overlay 
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Table 2. Rear Panel Connectors and Controls 

Item No. Item Description 
Power and Control Connectors 

1 AUX Reserved for future application. 
2 FUSE  With a 27 VDC input, provides 10-amp input power protection for 

the SL Rx.  
3 27 VDC IN + and -  

(Terminal Block) 
Provides input power connection for 27 VDC. 

4 ALARM NO, C, and NC  
(Terminal Block) 

Provides connection from the alarm relay to the base station alarm 
system. 

5 CONSOLE connector Provides an RS-232 serial interface connection to the PC. (You 
can verify that the system is in SuperLink mode (Regulate state) 
and check the system parameters using a PC.) 

6 GND Chassis ground lug. 
RF Connectors 

7 1 FILTER IN RF Connector 
(SL Rx input) 

N-type connector that receives RF signals from the Antenna for 
each SL Rx receive path. 

8A 1A LNA OUT RF Connector 
(SL Rx output) 

N-type connector that routes RF signals from each SL Rx receive 
path output to the base station front-end input. (Use complete row 
of A’s for one base station.) 

8B 1B LNA OUT RF Connector 
(SL Rx output) 

N-type connector that routes RF signals from each SL Rx receive 
path output to the base station front-end input. (Use complete row 
of B’s for the second base station.) 

 
 
Model Number Identification 
 
The SL Rx model number provides information on filter generation, frequency ranges, number 
of RF receive paths, and types of options selected. The model (and serial) numbers are located on 
the top cover, towards the back of the system. See Figure 10 for a description of the STI SL Rx 
model numbers. 
 

 
For systems shipped in 2004, the model (and serial) numbers are located on the 
bottom of the system, towards the front. 

 

Rack Mount

2 = 2 Channel
4 = 4 Channel
6 = 6 Channel

SUPERLINK RX MODEL NUMBERING

Cellular 850 MHz

A = A-Band
B = B-Band

850 A 2 RSL

SuperLink Rx

F1

Filter Configuration:
F1= Single Bandpass
F2= Dual Bandpass

OL

OL = Overlay Model
none = Standard Model

Figure 10. Model Numbering 
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Chapter 3  Unpacking the SuperLink Rx 

 
 
 
Reviewing the Contents of the SuperLink Rx Package 
 
When you unpack the SL Rx package, review the contents to ensure you received the supplied 
items as shown in Table 3. If you discover any items missing, call the CS-Hotline. 
 

Table 3. Equipment Supplied 

Item No. Item Part Number Qty Notes 
1 SL Rx, 2-Pak or 6-Pak As ordered 1 each 2-Pak or 6-Pak SL Rx as 

ordered. 
Rack Mount Brackets, 19-inch 
Right Side 
Left Side 

 
180-0605 
180-0606 

 
1 pair 

2A 
 
 
2B 
 

Rack Mount Brackets, 23-inch 
Right Side 
Left Side 

 
180-0609 
180-0606 

 
1 pair 

 
As ordered, one pair of either  
19-inch or 23-inch rack mount 
brackets ships with each SL Rx. 

3 Machine Screws, Round Head, 
Phillips Head  
10/32-inch x 1/2-inch long 

360-0098-0500 8 each Use four Round Head Screws to 
mount each rack mount bracket 
to the SL Rx.  

Hex head, Type F,  
#12-24 x .75-inch long 

360-0169-0750 4 each 4A 
 
4B Hex head, Type F,  

#10-32 x .75-inch long 
360-0168-0750 4 each 

Use four Hex head screws to 
mount the SL Rx with rack 
mount brackets to the base 
station. 

5 STI CD 831-0001 1 each Contains the product manual and 
the STI System Status Portal 
software that communicates with 
the SL Rx. 
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Unpacking the SuperLink Rx 
 
STI uses cutout protective foam packing to prevent damage to the system during shipment. The 
following steps ensure that you unpack the SL Rx properly. 
 

1. Inspect the shipping container for signs of damage. Report any damage to the  
CS-Hotline. 
  

2. Remove loose packing materials on top of the SL Rx. 
 

3. Remove the rack mount brackets located between the corner of the shipping container 
and the foam packing material. 
 

4. Remove the bag containing the attaching hardware for the rack mount brackets. The bag 
is taped to the top of the SL Rx. 
 

5. Remove the STI CD taped on top of the SL Rx. 
 

6. With foam packing materials in place, lift the SL Rx from the shipping container. Place 
the SL Rx on a work surface. 
 

7. Remove the foam packing from each end of the SL Rx. 
 

8. Do not remove the plastic ESD covers from the RF connectors at this time. Remove 
these covers when you are ready for the SL Rx Receive Path Gain test in Chapter 5, 
“Installing the SuperLink Rx.” 
 

9. Inspect the SL Rx for signs of damage. Report any damage to the CS-Hotline. 
 

10. Retain the shipping container and all packing materials for reuse. Store the shipping 
container in a dry place. 
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Instructions for Return Shipment 
 
The SL Rx may be returned to STI to incorporate an optional feature, upgrade to a newer model, 
or for repair. STI handles all upgrades and repair activity. To return a system, complete the 
following:  
 

1. Call the CS-Hotline for a Return Material Authorization (RMA) number. Provide the 
following information: 
 

� Model number (located on the rear panel or the bottom front of the SL Rx) 
� Serial number (located on the rear panel or the bottom front of the SL Rx) 
� Comprehensive description as to the nature of the return 

 

 
For systems shipped in 2004, the model (and serial) numbers are located on the 
bottom of the system, towards the front. 

 

 The representative will inform you about the return shipment process, including a brief 
explanation about shipping Hazardous Materials. You must be certified to ship 
Hazardous Materials.  
 

The representative will mail you a packet that contains the information you need to learn 
more about Hazardous Materials and to properly ship the system back to STI. 
 

2. The day you receive your paperwork, the representative will contact you to discuss 
Hazardous Materials. The representative will certify you after a brief discussion over the 
phone, concluding with a quiz. When you successfully complete the quiz, provide the 
representative with the following information to complete your certification: 
 

� Your title 
� Immediate supervisor’s name 
� Immediate supervisor’s email 

 

3. After you are certified, follow the instructions provided in the RMA packet to ship the 
system back to STI. 

 

 
Failure to properly package the SL Rx system could result in significant shipping 
damage. STI is not responsible for shipping damage due to improper packaging. 
See Figure 11 for appropriate packing procedures. 
 

Keep the original shipping container for return shipment, or request a new 
shipping container from STI. 
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Rear Foam Block 
oriented correctly 

Back Panel 
of SL Rx 

Front Foam Block 
Cross-Bar facing up

 

 
 

Figure 11. Foam Packaging Installation 
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Chapter 4  Installation Requirements 

 
 
 
Overview 
 
Before you install the SL Rx, review the installation requirements: 
 
� Establish the site requirements 
� Assemble the tools and materials required for installation 
� Assemble the functional checks test equipment 
� Review the PC requirements for the Java Runtime Environment/System Status Portal 

 

 
The tools, materials, and test equipment are not supplied with the SL Rx. The 
following sections guide you in preparing the items you need to install the  
SL Rx. If you have questions about the installation requirements, call the  
CS-Hotline. 

 
 
SuperLink Rx Requirements 
 
Site Requirements 
 
You are responsible for providing the facilities and environmental controls for the SL Rx 
installation. Review the following site requirements: 

 
� Sheltered enclosure with temperature and humidity control. 
� Conditioned air as required, maintaining the SL Rx between 0oC and 50oC. 
� Humidity control as required, maintaining the relative humidity level between 10% and 

95% (non-condensing). 
� Mounting location with unobstructed air vent space at the front and rear of the SL Rx. 
� 27 VDC Power Source (25 to 30 VDC) provided through a Power Distribution Panel 

Circuit Breaker of 20-amp capability (15 to 30 amps). 
� Remote monitoring connection for the SL Rx alarm relay. 
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Required Installation Tools and Materials 
 
You are responsible for providing hand tools and materials to install the SL Rx. Review the 
following requirements: 
 

Table 4. Hand Tools Required 

Item No. Item Notes 
1 Screwdriver, 1/8-inch flat blade For SL Rx terminal block screws. 
2 Screwdriver, Phillips #2 For attaching rack mount brackets (Table 3, Item 2A or 

2B) to the chassis, and the ground lug to the system. 
3 Hex driver, 5/16-inch For attaching Hex head screws (Table 3, Item 4A or 4B) 

to mount the SL Rx to the base station equipment rack. 
4 Wire Stripper For power wire installation. 
5 Wire Cutter (diagonal cutter) For power wire installation and wire tie removal. 

 
Table 5. Materials Required 

Item No. Item Qty Notes 
1 RF Jumper Cable, Flexible, 

Low Loss (1/2-inch). 
(Suggest FSJ-4 Andrew 
Cable or equivalent.) 

1 per receive 
path, length as 
required. 

Male N-type connectors on each end. This cable 
must be long enough to connect between the 
existing antenna feed coaxial input connector and 
the rack-mounted SL Rx. (Rerouting the existing 
feed jumper cable may be sufficient for this cable.) 

2 RF Jumper Cable, Flexible, 
Low Loss (1/2-inch). 
(Suggest LDF-4 Cable or 
equivalent.)  

1 per receive 
path, length as 
required. 
Double this 
quantity if 
using the 
Overlay 
model. 

Male N-type connectors on each end. This cable 
must be long enough to connect the rack-mounted 
SL Rx output to the existing antenna input 
connector of the base station receiver.  

3 Wire, Duplex 10-gauge Length as 
required. 

Power wire, 12-gauge for lengths up to 20 feet,  
10-gauge up to 30 feet (red and black wire 
preferred for color coding + and - power, 
respectively). A spade lug is recommended for 10 
AWG wire. 

4 Wire, Duplex 24-gauge Length as 
required. 

If desired, for connecting the SL Rx alarm relay 
output to the base system Alarm Control Unit. 

5 Wire, 6-gauge Length as 
required. 

For connecting the SL Rx chassis ground to the 
base station ground. 

6 Nylon Wire Ties As required. Used to dress cables after installation. 
7 20-amp Breaker As required. Used to install the system and perform functional 

checks. 
 

 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 20



Required Functional Checks Test Equipment 
 
You are responsible for providing test equipment to perform functional checks on the SL Rx. 
Review the following table for required test equipment: 
 

Table 6. Test Equipment Required 

Item No. Test Equipment Notes 
1 Digital Multimeter (DMM) or 

equivalent 
Checks the alarm relay and input power. 

2 Personal Computer (PC) with Comm 
Port 

Accesses SL Rx internal states using the serial port. See the 
“Reviewing PC System Requirements” section for more 
information. 

3 Straight-thru cable, DB-9 Female 
Connector to DB-9 Male Connector 
(50 feet maximum) 

Connects PC to SL Rx. 

4 Signal Generator, Radio Frequency Generates a continuous wave (CW) carrier at 830 MHz  
(A-Band) or 840 MHz (B-Band), with output level adjusted 
to -50 dBm. 

5 Spectrum Analyzer Receives and displays CW carrier at 830 MHz (A-Band) and 
840 MHz (B-Band), across levels -55 to -35 dBm; measure 
received power level accurately (+1 dB). 

6 Connector Adapter, N-Female to  
N-Female (N-type barrel) 

Replaces the SL Rx for test signal level calibration. 

 

 
HP 8921 Test Set, or equivalent, provides both the Signal Generator and the 
Spectrum Analyzer function. 

 
Reviewing PC System Requirements 
 
To communicate with the SL Rx, STI provides two programs you need to install on your PC:  
Java Runtime Environment and the System Status Portal. The Java Runtime Environment is 
required for the System Status Portal to operate properly. If you already have the Java Runtime 
Environment on your PC, you do not need to install this program. 

 
Review the system requirements to ensure your PC has the minimum system requirements to run 
these programs. Call the CS-Hotline if you have questions about the requirements. 
 
� Windows 95, 98 (1st or 2nd edition), 2000, NT 4.0 (with Service Pack 6), ME, or XP 
� Pentium 166 MHz or faster processor 
� 70 MB available disk space 
� 32 MB RAM minimum, 48 MB RAM (or higher) ideal 
� CD-ROM drive 
� Comm Port available (supporting 19.2K baud data rates) through a DB-9 connector 
� Internet Explorer 5.5 and higher, Netscape Navigator 6.2 and higher, or Netscape 

Communicator 4.79 and higher 
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Chapter 5  Installing the SuperLink Rx 

 
 
 
Overview 
 

 
Qualified technicians should install the SuperLink Rx system. Contact the  
CS-Hotline for assistance:  800.727.3648. 

 
Proper installation of the SL Rx consists of the following steps: 
 
� Installing the Java Runtime Environment/System Status Portal 
� Mounting the SL Rx 
� Connecting the power wire, chassis ground, and alarm relay 
� Performing power up/cooldown 
� Performing functional checks 
� Connecting RF cables 

 
Site-specific installation and checkout information may be available by calling the CS-Hotline. 
 
 
SuperLink Rx Installation Procedures 
 
Installing the Java Runtime Environment 
 
The Java Runtime Environment, version 1.4, supports the System Status Portal. This version is 
available on the STI CD shipped with the SL Rx. If you currently have this version installed on 
your PC, you do not need to install this program again. To install from the STI CD: 
 

1. Insert the STI CD into your CD-ROM drive. 
 

2. From the Start menu, choose Run…. The Run dialog box opens. 
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3. To locate the STI CD, click Browse…. The Browse dialog box opens, and defaults to 
the C: drive. Find the CD-ROM drive on your PC to display the contents of the  
STI CD. 
 

 
 

4. Double-click the JavaRE folder. This folder contains the setup file for the Java 
Runtime Environment:  j2re-1_4_0_01-windows-i586.exe. 
 

5. Double-click the setup file:  j2re-1_4_0_01-windows-i586.exe. The file path displays 
in the Run dialog box. Click OK to begin the installation, and the InstallShield 
Wizard dialog box opens. Click Next >. 
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6. Review the information on the License Agreement dialog box, and click Yes to 
continue with the installation. 
 

 
 

7. Choose a destination location. By default, the InstallShield Wizard chooses the C: 
drive to install the Java Runtime Environment. Install the program on the default drive:  
C:\Program Files\Java\j2re1.4.0_01. Click Next >. 
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7a. If you want to change the destination folder, click Browse…. The Choose Folder 
dialog box opens. Choose a folder to install the Java Runtime Environment, and click 
OK to continue with the installation. 

 

 
 

8. Choose the browser used on your PC:  Microsoft Internet Explorer or  
Netscape 6. Click Next >. 

 

 
For Netscape users only. Verify that the Java Plugin box is checked to enable 
proper operation of the System Status Portal. Choose Edit > Preferences. Find 
Category and click Advanced. In this window, check Enable Java Plugin, and 
click OK.  

 

 
 

 The InstallShield Wizard installs the Java Runtime Environment on your PC. When 
the installation is complete, the Java Runtime Environment InstallShield Wizard 
closes. 
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Installing the System Status Portal 
 
The System Status Portal provides a user-friendly interface to observe the operating parameters 
of the SL Rx. For more information about using the System Status Portal, see Appendix A, 
“Using the System Status Portal.” 
 

1. Locate the STI CD using Start > Run…. The Run dialog box opens. 
 

 
 

2. To locate the STI CD, click Browse…. The Browse dialog box opens, and defaults to 
the C: drive. Find the CD-ROM drive on your PC, and display the contents of the  
STI CD. 
 

 
 

3. Double-click the Application folder. The folder contains the setup file for the System 
Status Portal:  setup.exe. 
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4. Double-click the setup file:  setup.exe. The file path displays in the Run dialog box. 

Click OK to begin the installation, and the InstallShield Wizard dialog box opens. 
Click Next >. 
 

 
 

5. Choose a Destination Folder. By default, the InstallShield Wizard chooses the C: 
drive to install the System Status Portal. Install the program on the default drive and 
folder:  C:\Program Files\STI\App\. Click Next >. 
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5a. If you want to change the destination folder, click Change…. The Change Current 
Destination Folder dialog box opens. Choose a folder to install the System Status 
Portal, and click OK to continue with the installation. 

 

 
 

6. Review the installation settings before you complete the installation. If you need to 
make any changes, click < Back to review the previous screens. Click Install to 
continue with the installation. 
 

 
 
 
 
 
 
 
 
 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 29



7. When the installation is complete, the InstallShield Wizard Completed dialog box 
displays. Click Finish. You are now ready to use the System Status Portal. 
 

 
 
Mounting the SuperLink Rx on the Equipment Rack 
 
The rack mount location of the SL Rx should allow the RF jumper cable attached to the antenna 
bulkhead to reach the input connector of the SL Rx. If this is not possible, you need to replace 
the jumper cable with another cable of sufficient length to complete the connection. This cable 
contributes to the input noise figure, so for optimum performance the cable should be of 
minimum length, and have a low insertion loss. 
 

 

The SL Rx contains components that are subject to damage from electrostatic 
discharge (ESD). Take precautionary measures when handling components 
mounted on the rear panel of the SL Rx. 

 

 
Your SL Rx shipment includes the rack mount brackets (Table 3, Item 2A or 2B) 
you specified at the time of purchase. Use the rack mount brackets to mount the 
system as shown in Figure 12. 

 

1. Using a Phillips #2 screwdriver (Table 4, Item 2), secure the rack mount brackets 
(Table 3, Item 2A or 2B) to the SL Rx using four machine screws (Table 3, Item 3) for 
each bracket. Review the part numbers to ensure that the rack mount brackets are 
installed on the correct side of the SL Rx. 

 

 
Ensure that the selected mounting location provides an unobstructed air vent 
space at the front and rear of the SL Rx. 

 

2. Install the SL Rx into the equipment rack. Using a Hex driver (5/16-inch)  
(Table 4, Item 3), secure the SL Rx to the equipment rack using the Hex head screws 
(Table 3, Item 4A or 4B) provided. 

 

 
The SL Rx can be mounted to the cable tray or directly to a wall. For 
information on price and availability of cable tray or wall mounting kits, call the 
CS-Hotline. 
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23-inch
Bracket

Round Head
Screws (4)

Note:  19- or 23-inch mounting
brackets can be attached to the
center or front of the system.

Figure 12. Example of SuperLink Rx with 23-inch Rack Mount Brackets, Center-Mounted 

 
Connecting the Chassis Ground 
 
Connect the chassis ground to the base station ground using 6-gauge green wire (Table 5,  
Item 5). 
 

1. Using a Phillips #2 screwdriver (Table 4, Item 2), remove the spade lug. 
 

2. Crimp the lug to the green wire (Table 5, Item 5), and then reattach the lug to the 
chassis ground. 
 

3. Connect the other end of the green wire to the base station ground halo. 
 
Connecting the Power Wire  
 

 
Do not exceed a 30-amp circuit breaker rating on a 12-gauge wire or a 40-amp 
circuit breaker rating on a 10-gauge wire. Excess current capacity may result in a 
fire hazard. Qualified electricians should install the power wire, providing 
recommendations based on the set up. 

 

 
Keep the power wire to less than 30 feet in length. A 10-gauge wire is preferred 
but a 12-gauge wire may be used for wire lengths of less than 20 feet. 

 

 
Before you proceed, set the power source circuit breaker to the open or off 
position. Failure to comply may result in personnel injury. 

 

1. Select a breaker in the Power Panel. Operate (open) the breaker to turn off power in the 
circuit. 
 

2. Run the power wire (Table 5, Item 3) from the base station power distribution circuit 
breaker box to the terminal block on the rear panel of the SL Rx. The terminal block 
connections are labeled 27 VDC IN + and -. See Figure 6, 7, 8, or 9 for rear panel 
terminal block connections on the SL Rx. 
 

3. Connect the wires at each end, being careful to maintain the correct voltage polarity. 
Do not close the circuit breaker at this time. 
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Connecting the Alarm Relay 
 
The alarm relay provides a warning alarm that you can monitor remotely. You have the option of 
connecting the output of the SL Rx alarm relay to the base station alarm control system. See 
Figure 13 for the states of the alarm relay. 
 
Some base station alarm systems require an open contact while others require a closed circuit. 
The SL Rx will allow for either choice. Determine which contacts to use by consulting the Base 
Station Alarm System documentation.  
 

1. Using a screwdriver (1/8-inch) flat blade (Table 4, Item 1), connect a 24-gauge duplex 
wire (Table 5, Item 4) between the base station alarm panel and the terminal block 
connections on the SL Rx labeled C (Common) and NC (Normally Closed) or NO 
(Normally Open), whichever is required by the alarm system. 

 
Alarm Relay Normal Operation Condition

NO = Open in normal operation
   C = Common
NC = Closed in normal operation

Alarm Relay Fault Condition (Failure)

NO = Closed during fault condition
   C = Common
NC = Open during fault condition

Note:  Alarm Relay, dry contacts, rated at 2-amps.

SuperLink Mode

Bypass (Fault) Mode

C

NO

NC

C

NO

NC

Figure 13. Alarm Relay in Normal and Alarm States 
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Performing Power Up/Cooldown 
 

 
Before you proceed, set the power source circuit breaker to the open or off 
position. Failure to comply may result in personnel injury. 

 

1. Ensure the power source circuit breaker (Table 5, Item 7) is set to the open or off 
position. 
 

2. Remove the fuse from the fuse holder located on the rear panel of the SL Rx. 
 

3. Set the power source circuit breaker to the closed or on position. 
 

4. Verify that the SL Rx input voltage at the terminal block contact reads 27+2 VDC on 
the DMM. Verify correct polarity. 
 

5. Reinstall the fuse in the fuse holder. 
 

6. Apply power to the SL Rx by setting the power source circuit breaker to the closed or 
on position. 

 

 
Initially, both LEDs on the front panel of the SL Rx remain on and steady during 
cooldown. 
 

When the SL Rx cryogenic chamber has reached operating temperature (~78 K), 
the STATUS LED will be steady GREEN and the BYPASS LED will be off. 

 

7. The SL Rx will automatically switch from Bypass mode to SuperLink mode  
(Regulate state) when cooled. If the system fails to go into SuperLink mode  
(Regulate state) within 5 hours, call the CS-Hotline. 

 

 
When the SL Rx reaches SuperLink mode (Regulate state) the STATUS LED 
will be GREEN. When the system is in Bypass mode, the RF path relays operate 
to exclude the High Temperature Superconductor (HTS) filter and LNA from the 
receive path, indicated by a steady RED LED. When the system switches to 
SuperLink mode (Regulate state), the STATUS LED changes to solid GREEN. 
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Table 7 provides the following states, relay settings, and indicator readings for the SL Rx. 
 

Table 7. SuperLink Rx Internal States and Status 

 State Bypass Indicators  
Mode Name Relay 

State 
BYPASS 

(RED) 
STATUS 
(GREEN) 

Description 

Bypass 0. Initial Bypass On  On Initializes the system and powers up the 
cooler motor to minimum power setting. 
Transitions to the Cooldown state. 

Bypass 1. Cooldown Bypass 
 
 
 

On On Cools down the CoRE. The Cooldown 
state runs the cooler motor at the 
maximum motor drive power, based on 
the cooldown profile of the cooler. The 
LNAs turn on in the Cooldown state 
when the cold stage narrow range 
temperature is within operating bounds. 
Transitions to Regulate state when the 
narrow range temperature is within its 
operating tolerance for 300 seconds (LNA 
on). 

SuperLink 2. Regulate Normal Off On Regulates the cold stage temperature 
indefinitely. 

Bypass 3. Bypass 
(Fault) 

Bypass On Off Continues to regulate the cooler 
temperature. This Fault state occurs when 
the Input Voltage is out of bounds. When 
the Input Voltage fault has cleared, the 
system transitions back to the Regulate 
state (Automatic mode). 

Bypass 4. Shutdown 
(Fault) 

Bypass On Off The cooler motor drive reduces to zero 
and is turned off. Transitions back to 
Initial state in Automatic mode when cold 
stage narrow range temperature has 
warmed sufficiently to be out of its valid 
range and the faults are cleared. 

Bypass 5. Forced 
Bypass 

Bypass Flash if On Flash if On Forces the system into Bypass mode 
regardless of any other conditions. At 
least one LED should always flash on if 
in Forced Bypass mode. 

 
 

  Regulate state = SuperLink mode. In all other states, the SL Rx is in Bypass mode. 
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Performing Functional Checks 
 
Before you can perform any functional checks for the SL Rx, the system must be in SuperLink 
mode (Regulate state). If the system is not in SuperLink mode (Regulate state) after five hours, 
review Chapter 6, “Troubleshooting Tips.” When your system is in SuperLink mode  
(Regulate state), continue with the functional checks. 
 
The functional checks consists of the following procedures: 
 
� Console connection and operation 
� Alarm relay test 
� Test generator calibration data 
� SL Rx receive path gain test 

 
Review the test equipment required for these functional checks in Table 6. 
 

 
Before continuing with the functional checks, turn on the RF Signal Generator 
(Table 6, Item 4) and the Spectrum Analyzer (Table 6, Item 5) to warm them up. 
Consult the equipment operator manuals for proper test equipment warm up 
time. 

 
Console Connection and Operation  
 
Check the operational parameters of the SL Rx. 
 

1. Connect the DB-9 cable (Table 6, Item 3) to your PC (Table 6, Item 2) and the SL Rx 
as shown in Figure 14. 

SuperLink Rx

CONSOLE

3 2 5 DB-9
Connector

Ground
Receive Data
Transmit Data

RF connections in
accordance with site
requirements

Comm Port to PC

5

2

3

PC
(Table 6, Item 2)

DB-9
ConnectorStraight-thru Cable

(Table 6, Item 3)

Alarm Wire

27 VDC
Power
Source

Power Wire

Terminal Block

To Alarm
Contacts

+
-POWER

27 VDC IN

NC

C
NO

ALARM

Figure 14. PC Connection to the SuperLink Rx 
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2. From the Start menu, choose Programs > STI > STI System Status Portal. 
 

 
 

 The System Status Portal opens. 
 

 
 

3. Click Communicate with Unit to establish communication with the SL Rx. 
 

4. Select the correct Comm Port to establish communication, and then click OK. 
Typically, the System Status Portal selects COM1 as the available Comm Port. 
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4a. If a connection cannot be established after five seconds, the Serial Port Connection 
Error dialog box displays. 

 

 
 

4b. Review the message in the dialog box, and try reconnecting again. If the problem 
persists, call the CS-Hotline. 

 

 
See Chapter 6, “Troubleshooting Tips” if you cannot establish communication 
with your system, or call the CS-Hotline. 

 

 
Before you check the Wide Range Cold Finger Temperature, the system must be 
in SuperLink mode (Regulate state), indicated by a steady GREEN light on the 
STATUS LED, or cools within 5 hours. If the system fails to go into SuperLink 
mode (Regulate state) within 5 hours, call the CS-Hotline. 

 

5. Read the Wide Range Cold Finger Temperature (View > Status > Measure) and 
verify that the temperature falls in the range of 79+4 K. If the temperature is out of 
range, call the CS-Hotline. 

 
Alarm Relay Test 
 
Check the operation of the alarm relay. 
 

 
To check the alarm relay parameters of the SL Rx, the system must be in 
SuperLink mode (Regulate state) before proceeding. 

 

Testing the Connection 
 

1. Push the FORCED BYPASS button (Figure 5) on the front panel of the SL Rx. The 
STATUS LED will slow flash GREEN. The alarm relay is now placed in an alarm 
condition. Verify that the base station alarm is activated. 
 

2. Push the FORCED BYPASS button (Figure 5) again. The system will return to 
SuperLink mode (Regulate state), indicated by a steady GREEN STATUS LED. The 
alarm relay is now placed in normal condition. Verify that the base station alarm 
system is no longer activated. 
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Testing the Alarm Relay 
 

3. Push the FORCED BYPASS button (Figure 5) on the front panel of the SL Rx. 
 

 
The STATUS LED will slow flash GREEN; the alarm relay is now in alarm 
condition. 

 

4. Set the DMM (Table 6, Item 1) to measure resistance. 
 

5. Place the DMM leads between the SL Rx terminal block connections labeled ALARM 
C and NO. The DMM should read less than 10 ohms. 
 

6. Move the DMM leads between terminal block connections labeled ALARM C and 
NC. The DMM should read greater than 10,000 ohms. 
 

7. After you record the measurements, push the FORCED BYPASS button again. The 
system will no longer be in the Forced Bypass mode. 

 

 

Ensure you have turned the Forced Bypass off. Otherwise, the SL Rx will remain 
in Bypass mode, as indicated by the STATUS LED continuously flashing 
GREEN. 

 

 
The SL Rx STATUS LED will be steady GREEN, indicating the system is in 
SuperLink mode (Regulate state), with the alarm relay in normal position. 

 

8. Place the DMM leads between the SL Rx terminal block connections labeled ALARM 
C and NO. The DMM should read greater than 10,000 ohms. 
 

9. Move the DMM leads between the SL Rx terminal block connections labeled ALARM 
C and NC. The DMM should read less than 10 ohms. 

 
Test Generator Calibration Data 

 
A signal power measurement is the reference level for verifying the SL Rx RF path gain and loss 
values. Set up the SL Rx test RF reference levels. 
 

1. Turn on the RF Signal Generator (Table 6, Item 4) and the Spectrum Analyzer  
(Table 6, Item 5) and allow them to warm up. Consult the equipment operator manuals 
for proper test equipment warm up time. 
 

2. Set the RF Signal Generator to output a CW signal to the following: 
 

For SL Rx A-Band: 
� 830+3 MHz 
� Power level set to -50+1 dBm 

 

For SL Rx B-Band: 
� 840+3 MHz 
� Power level set to -50+1 dBm 

 

3. Connect the RF Signal Generator output to the Spectrum Analyzer as shown in  
Figure 15, substituting an N-type barrel connector adapter (Table 6, Item 6) for the  
SL Rx. 
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4. Measure the signal frequency and power level, and make a note of both values in 
Appendix C, “Receive Path Gain/Loss Calculator.” This signal power measurement is 
used as the reference level for finding the SL Rx RF path gain and loss values. 
 

5. Remove the N-type barrel connector adapter (Table 6, Item 6). 
 

Spectrum Analyzer
(Table 6, Item 5)

RF
Signal

Generator
(Table 6,
Item 4)

N-type
Barrel

(Table 6, Item 6)

Figure 15. Test Generator Calibration Reference Level Measurement Diagram 

 
SL Rx Receive Path Gain Test 
 
Calculate the RF path loss (Bypass) and gain (SuperLink) levels for the SL Rx preamplifier 
receive paths. Record the measurements in Appendix C, “Receive Path Gain/Loss Calculator,” or 
use the Microsoft® Excel file labeled Appendix C in the SuperLink Rx Operation and 
Installation Manual folder on the STI CD. 
 

 

The SL Rx contains components that are subject to damage from electrostatic 
discharge (ESD). Take precautionary measures when handling components 
mounted on the rear panel of the SL Rx. 

 

 
During these procedures, refer to the SL Rx test setup diagram in Figure 16. 

 

1. Remove the plastic ESD covers from the RF connectors to perform the RF test. Store 
the covers in the shipping container. 
 

2. To check the RF gain and loss on SL Rx receive path number 1, connect the RF Signal 
Generator (Table 6, Item 4) to the SL Rx N-type connector labeled 1 FILTER IN. 
 

3. Connect the Spectrum Analyzer (Table 6, Item 5) to the SL Rx N-type connector 
labeled 1 LNA OUT. 

 

4. 
 

Push the FORCED BYPASS button (Figure 5) on the front panel of the SL Rx. 
 

5. Measure the Bypass loss of the RF output level for receive path 1 and record in 
Appendix C, “Receive Path Gain/Loss Calculator.” 
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6. Measure the Regulate gain of the RF output level for receive path 1 and record in 

Appendix C, “Receive Path Gain/Loss Calculator.” 
 

7. Repeat steps 2-6 to check the RF gain and bypass loss on all additional SL Rx receive 
paths based on your configuration. You must check each channel one at a time. 
 
 

8. Calculate the RF path loss (Bypass) and gain (SuperLink) by subtracting the reference 
level recorded as a result of the Test Generator Calibration Data procedure.  
(See Appendix C, “Receive Path Gain/Loss Calculator.”) 
� Gain:  13+2 dB 
� Loss:  -1+1 dB 

 

 
 

Make sure that the system is in SuperLink mode (Regulate state), indicated by a 
steady GREEN LED. 

 

 
For the Overlay model, use the following figures to determine the RF gain and 
bypass loss:   
 

� Gain:  9+2 dB 
� Loss:  4+1 dB  

 

9. 
 

Disconnect the RF Signal Generator (Table 6, Item 4) and the Spectrum Analyzer  
(Table 6, Item 5) and secure them. Leave the PC connected to the SL Rx at this time. 
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Antenna

 1.  Receive Path 1 RF Connections shown. RF connections for all additional receive paths are the  same.
 2.  Connect alarm wire in accordance with user-specified Alarm requirements.

1 FILTER IN 1 LNA OUT

(See Note 1)

SuperLink Rx

CONSOLE

3 2 5 DB-9
Connector

Base Station
 Front End
 Filter/LNA

Ground

Receive Data

Transmit Data

NOTES:

N-Type
(Table 5,
Item 1)

N-Type
(Table 5,
Item 2)

Straight-thru Cable
(Table 6, Item 3)

DB-9
Connector

5

2

3

27 VDC
Power
Source

Power Wire

To Alarm
Contacts

Alarm Wire
(See Note 2)

Terminal Block

+
-POWER

27 VDC IN

NC

C
NO

ALARM

PC
(Table 6, Item 2)

Comm Port on PC

1 FILTER IN 1A LNA OUT
1B LNA OUT

Overlay Solution

Standard Model

Figure 16. Gain Test Setup 
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Connecting RF Cables 
 
This portion of the procedure connects the SL Rx into the RF receive paths of the base station. 
The required cables are listed in Table 5, and the connections are shown in Figure 17. 
 

 

The SL Rx contains components that are subject to damage from electrostatic 
discharge (ESD). Take precautionary measures when handling components 
mounted on the rear panel of the SL Rx. 

 

 

For base station equipment that incorporates a duplexer, ensure that cable 
connections made between the duplexer and the SL Rx are from the receive side 
of the duplexer only. Connecting cables from the duplexer transmit port to the 
SL Rx will cause damage to the SL Rx. 

 

1. In the first receive path, disconnect the existing antenna input jumper cable from the 
base station front-end. Connect that cable to the SL Rx N-type connector labeled  
1 FILTER IN. If the antenna cable does not reach the SL Rx input connector, replace 
it with a jumper cable (Table 5, Item 1) of sufficient length. 
 

2. Using the RF jumper cable (Table 5, Item 2), connect the SL Rx connector labeled  
1 LNA OUT to the base station front-end. At this point the RF path from the antenna 
through the SL Rx and into the base station receiver should be complete and carrying 
traffic. 

 

 

Work with only one receive path at a time. Completely reconnect and verify 
operation of one receive path before moving to another receive path. If both 
receive paths in a sector are disconnected, all service will be lost in that sector. 

 

3. Verify that signal traffic is evident in the Spectrum Analyzer display by connecting to 
an open RF port in the power divider or sampling at the input to the base station  
front-end. If no traffic is observed, review the “Installation Troubleshooting” section in 
Chapter 6, “Troubleshooting Tips.” 
 

 
Please connect adjacent channels as Main/Diversity pairs as follows: 
 
            
 
   
 
 
  

 

4. 
 

Repeat steps 1-
 

5. At the conclusi
wire ties (Tabl

 

 

The S
perfo
SL R
page
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            1 & 2
           
            3 & 4
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3 for the remaining receive paths. 

on of the RF cable connections to the SL Rx, dress cables using nylon 
e 5, Item 6) as required. 

 

L Rx has no alarm associated with an RF open/short failure. If the RF 
rmance of one or more channels has degraded, then the corresponding  
x channel(s) should be measured. See the SL Rx Receive Path Gain Test on 
 39 for more information. 
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Connecting RF Cables (Overlay)  
 
This portion of the procedure connects the SL Rx with Overlay model into the RF receive paths 
of both base stations. The required cables are listed in Table 5, and the connections are shown in 
Figure 17. For duplexed antennas (combined transmitter and receiver on one antenna), see 
specific application notes for your base station. 
 

 

The SL Rx contains components that are subject to damage from electrostatic 
discharge (ESD). Take precautionary measures when handling components 
mounted on the rear panel of the SL Rx. 

 

 

For base station equipment that incorporates a duplexer, ensure that cable 
connections made between the duplexer and the SL Rx are from the receive side 
of the duplexer only. Connecting cables from the duplexer transmit port to the 
SL Rx will cause damage to the SL Rx. 

 

1. In the first receive path, disconnect the existing antenna input jumper cable from the 
base station front-end. Connect that cable to the SL Rx N-type connector labeled  
1 FILTER IN. If the antenna cable does not reach the SL Rx input connector, replace 
it with a jumper cable (Table 5, Item 1) of sufficient length. 
 

2. Using the RF jumper cable (Table 5, Item 2), connect the SL Rx connector labeled  
1B LNA OUT to the original base station front-end. At this point the RF path from the 
antenna through the SL Rx and into the base station receiver should be complete and 
carrying traffic. 

 

 

Work with only one receive path at a time. Completely reconnect and verify 
operation of one receive path before moving to another receive path. If both 
receive paths in a sector are disconnected, all service will be lost in that sector. 

 

3. Verify that signal traffic is evident in the Spectrum Analyzer display by connecting to 
an open RF port in the base station’s receiver assembly power divider or sampling at 
the input to the base station front-end. If no traffic is observed, review the “Installation 
Troubleshooting” section in Chapter 6 “Troubleshooting Tips.” 
 

4. Repeat steps 1-3 for the remaining receive paths for the original base station, using the 
“B” LNA. 
 

5. Repeat steps 2-4 for the “A” LNA outputs, this time connecting to the added base 
station. 
 

6. At the conclusion of the RF cable connections to the SL Rx, dress cables using nylon 
wire ties (Table 5, Item 6) as required. 

 

 

The SL Rx has no alarm associated with an RF open/short failure. If the RF 
performance of one or more channels has degraded, then the corresponding  
SL Rx channel(s) should be measured. See the SL Rx Receive Path Gain Test on 
page 39 for more information. 
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Antenna

 1.  Receive Path 1 RF Connections shown. RF connections for all additional receive paths are the  same.
 2.  Connect alarm wire in accordance with user-specified Alarm requirements.
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Figure 17. Cabling Diagram, Cascade and Overlay 
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Chapter 6  Troubleshooting Tips 

 
 
 
Overview 
 
Problems may occur during installation, or from hardware or software failures that occur during 
operation. This chapter identifies the most common problems, providing troubleshooting tips to 
resolve them.   
 
If your problem does not appear in this chapter, please call the CS-Hotline for assistance.   
 

Problem No. Description Page No. 
   

1 System Status Portal will not install. 
 

Page 46 

2 System Status Portal does not run. 
 

Page 46 

3 Cannot establish communication with SL Rx. 
 

Page 47 

4 No traffic in SuperLink mode (Regulate state). A traffic signal 
does not appear on the Spectrum Analyzer (detected at the 
switch or directly in the receive path after the SL Rx). 
 

Page 47 

5 LED flashes RED and/or GREEN. 
 

Page 48 

6 Fuse blows out or circuit breaker trips. 
 

Page 48 

7 The SL Rx does not reach SuperLink mode (Regulate state) after 
five hours. 
 

Page 49 

8 Alarm Relay Test failed. 
 

Page 50 

9 Receive Path Gain Test failed. 
 

Page 50 

10 In SuperLink mode (Regulate state), the alarm signals when the 
RF cable is connected between the SL Rx output and receive 
input. 
 

Page 51 

11 BYPASS LED is RED (Alarm is on). 
 

Page 51 

12 RF Performance is not optimal, detected by the following 
conditions:  degradation in statistical performance, customer 
complaints, or Base Station Built-in Test (BIT) failure. 
 

Page 52 

13 Abnormal SL Rx noise. 
 

Page 52 
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Installation Troubleshooting 
 
 
Problem 1 

 
System Status Portal will not install. 
 

  
Cause 1.1 Your PC’s operating system (OS) is not compatible with the System Status 

Portal. 
  

Solution 1.1 See the “Reviewing PC System Requirements” section on page 21 to see 
what OS is compatible with the System Status Portal. 

  
Cause 1.2 Other. 
  

Solution 1.2 Call the CS-Hotline. 
 
 
Problem 2 

 
System Status Portal does not run. 
 

  
Cause 2.1 Java Runtime Environment may not be installed correctly. 
  

Solution 2.1a Check if the Java Runtime Environment is installed (Start > Programs > 
Java 2 Runtime Environment). If the program is not available, install the 
program from the STI CD, and run the System Status Portal again. 

  

Solution 2.1b Check if you have the correct version (1.4) of the Java Runtime 
Environment installed. If the correct version is not available, uninstall the 
version on your PC, and install the version of the program from the STI CD.

  
Cause 2.2 The System Status Portal installation failed. 
  

Solution 2.2 If the installation of the System Status Portal failed, reinstall the program 
again. If it fails a second time, call the CS-Hotline to obtain a new STI CD. 

  
Cause 2.3 Other. 
  

Solution 2.3 Call the CS-Hotline. 
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Problem 3 

 
Cannot establish communication with SL Rx. 
 

  
Cause 3.1 Faulty straight-thru cable. 
  

Solution 3.1 Use a DMM to check the continuity of the cable. Pin-to-pin connections are 
shown in Figure 16. 

  
Cause 3.2 Straight-thru cable is not seated properly. 
  

Solution 3.2 Reseat the cable and try again. 
  
Cause 3.3 Unavailable Comm (serial) Port. 
 

Solution 3.3 
 

If you run the System Status Portal and the cables are connected to the SL 
Rx, but you cannot establish communication with the system, an error 
dialog box opens with a serial communications message. Change the Comm 
Port, and connect to the SL Rx again. If the problem persists, call the  
CS-Hotline. 

  
Cause 3.4 Other. 
  

Solution 3.4 Call the CS-Hotline. 
 
 
Problem 4 

 
No traffic in SuperLink mode (Regulate state).  A traffic signal 
does not appear on the Spectrum Analyzer (detected at the 
switch or directly in the receive path after the SL Rx). 
 

  
Cause 4.1 RF cable connections are not correct. 
  

Solution 4.1 Check the cables for proper connection (see Figure 17). If the cables are 
connected properly, then push the FORCED BYPASS button (Figure 5). If 
you do not see traffic, see Cause 4.2. If you see traffic, the cables may be 
reversed. Reconnect the cables so the antenna connects to the SL Rx input 
and the output connects to the base station. 

  
Cause 4.2 Cables not mated or broken cable. 
  

Solution 4.2 Remove cables one at a time, and do a physical inspection of the conductor 
and connectors. Use a DMM to check the center conductor. Replace any 
bad cables found. Recheck the RF cabling and try the RF performance test 
again. 

 
Cause 4.3 

 
Other. 

  

Solution 4.3 Call the CS-Hotline. 
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Problem 5 

 
LED flashes RED and/or GREEN. 
 

  
Cause 5.1 SL Rx placed in Forced Bypass mode. 
  

Solution 5.1 Push the FORCED BYPASS button (Figure 5) to allow a chance for the 
system to reach SuperLink mode (Regulate state). If the LED becomes 
steady, the system is no longer in Forced Bypass. 

  
Cause 5.2 Other. 
  

Solution 5.2 Call the CS-Hotline. 
 
 
Problem 6 

 
Fuse blows out or circuit breaker trips. 
 

  
Cause 6.1 Incorrect voltage polarity applied. 
  

Solution 6.1 Check that the voltage polarity matches the labels on the terminal block. If 
the polarity is correct, then continue with Cause 6.2. If the polarity is 
incorrect, change the polarity, replace the fuse, and/or reset the circuit 
breaker. Before you remove the fuse, turn off the circuit breaker to prevent 
injury. 

  
Cause 6.2 Incorrect voltage applied. 
  

Solution 6.2 Remove the fuse, close the circuit breaker, and check the voltage on the 
terminal block. The voltage should read 27+2 VDC, but if not call the  
CS-Hotline. Before you remove the fuse, turn off the circuit breaker to 
prevent injury. 
 

Cause 6.3 Wrong circuit breaker rating. 
  

Solution 6.3 Replace the fuse, and try again. Before you remove the fuse, turn off the 
circuit breaker to prevent injury. If the circuit breaker blows, check the 
rating. The circuit breaker rating should read 15 to 30 amps. Replace the 
circuit breaker if necessary. 
 

Cause 6.4 Other. 
  

Solution 6.4 Call the CS-Hotline. 
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Problem 7 
 

 
The SL Rx does not reach SuperLink mode (Regulate state) 
after five hours. 
 

 
Cause 7.1  

 
SL Rx is in Forced Bypass mode. 

  

Solution 7.1 Check if the LED is flashing GREEN. If so, the system is in Forced Bypass 
mode. Push the FORCED BYPASS button (Figure 5) to go back to 
SuperLink mode (Regulate state). When a steady GREEN STATUS LED 
displays, the system is in SuperLink mode (Regulate state). If the problem 
persists, call the CS-Hotline.  

  
Cause 7.2 Source voltage is low under load. 
  

Solution 7.2 Measure the voltage with a DMM. Replace the power wire and/or breaker if 
necessary. 

  
Cause 7.3 Other. 
  

Solution 7.3 Establish communication with the system using the System Status Portal 
(Start > Programs > STI > STI System Status Portal). With the program 
open, click Communicate with Unit to connect to a Comm Port, and 
establish communication with the SL Rx. To observe the Cold Stage Wide 
Range Temperature, from the System Status Portal, choose  
View > Status > Measure. Review the temperature. If the temperature is 
not in the range of 79+4 K, call the CS-Hotline. 
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Problem 8 

 
Alarm Relay Test failed. 
 

  
Cause 8.1 Relay wire is not making a proper connection. 
  

Solution 8.1 Use an ohmmeter to measure connectivity from the SL Rx to the alarm 
relay. If either connection is bad, reset the wires or replace them and try 
connecting again. If both connections are good, see Cause 8.2. 

  
Cause 8.2  Alarm has been mis-wired. 
  

Solution 8.2 Ensure that the one wire is connected to the terminal block connection 
labeled C and one wire is connected to NC or NO. 
 

Cause 8.3 Alarm cable fault (alarm on, but front panel shows a steady GREEN LED). 
  

Solution 8.3 Inspect alarm cable and connections at both ends. Set and reset the alarm by 
using the FORCED BYPASS button (Figure 5) on the front panel, and 
check the operation at both ends of the alarm cable. See the “Connecting the 
Alarm Relay” section on page 32 for more information. 
 

Cause 8.4 Other. 
  

Solution 8.4 Call the CS-Hotline. 
 
 
Problem 9 

 
Receive Path Gain Test failed. 
 

  
Cause 9.1  Test setup error. 
  

Solution 9.1 Recheck the connection to the SL Rx, and try the receive path gain test 
again. 

  
Cause 9.2 Used wrong test frequency. 
  

Solution 9.2 Use 830 MHz A-band and 840 MHz B-band. The band is included in the 
Model Number (e.g. 850SLA2F1R(OL) is an A-band, and 
850SLB2F1R(OL) is a B-band. Note that “OL” indicates the model number 
includes the Overlay model). 

  
Cause 9.3 Attempting to measure backwards or cross receive paths. 
  

Solution 9.3 Ensure that you inject the signal into the N-type input ports and that they 
are measured at the output ports with the same receive path number. 

  
Cause 9.4 Other. 
  

Solution 9.4 Call the CS-Hotline. 
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Problem 10 

 
In SuperLink mode (Regulate state), the alarm signals when the 
RF cable is connected between the SL Rx output and receive 
input. 
 

  
Cause 10.1 DC bias is on the center conductor of the coaxial cable. 
  

Solution 10.1 Some base stations allow for DC bias on the coaxial line to provide power 
to a tower mount amplifier. Measure the DC bias from the center conductor 
to the ground of the receiver input. If there is bias, consult the Base Station 
documentation to turn off the Tower Top Amplifier bias voltage. 

  
Cause 10.2 Tower Top Amplifier still connected. 
  

Solution 10.2 Climb the tower and remove the Tower Top Amplifier. This causes 
problems for both the SL Rx input and/or output if the DC power is 
connected. 

  
Cause 10.3 Other. 
  

Solution 10.3 Call the CS-Hotline. 
 
 
Operation Troubleshooting 
  
 
Problem 11 
 

 
Bypass LED is RED (Alarm is on). 

  
Cause 11.1 SL Rx has out-of-range condition. 
  

Solution 11.1 � Establish communication with the system using the System Status 
Portal (Start > Programs > STI > STI System Status Portal). 
With the program open, click Communicate with Unit to connect 
to a Comm Port, and establish communication with the SL Rx. 
Verify the alarm and characterize the problem. Take note of any 
logged faults. 

� If the problem is input power, use a DMM to investigate the 
problem. The input power should be between 25 to 30 VDC. 

� If the problem persists, call the CS-Hotline. 
  
Cause 11.2 Other. 
  

Solution 11.2 Call the CS-Hotline. 
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Problem 12 

 
RF Performance is not optimal, detected by the following 
conditions: 
� Degradation in statistical performance 
� Customer complaints 
� Base Station Built-in Test (BIT) failure 

 
  
Cause 12.1 Open/short in SL Rx receive path. 
  

Solution 12.1 Check the gain of each receive path of the SL Rx, one receive path at a 
time. Inject the RF signal to the input of the SL Rx (A-Band 830 MHz,  
B-Band 840 MHz), and sample the signal at any point further up the RF 
chain. Check the measurement in SuperLink mode (Regulate state) and 
record. Place the system into Forced Bypass mode and then recheck the 
measurement. The difference between the two readings should be ~13 dB. 
Check each subsequent receive path in the same manner. If you discover a 
receive path that is not ~13 dB in SuperLink mode (Regulate state), but in 
Forced Bypass mode, call the CS-Hotline. 

  
Cause 12.2 Other. 
  

Solution 12.2 Call the CS-Hotline. 
 
 
Problem 13 

 
Abnormal SL Rx noise. 
 

  
Cause 13.1 SL Rx becomes abnormally loud. 
  

Solution 13.1 � Check for loose mounting hardware, cover screws, and other 
hardware. 

� Check the panel. If the LEDs display RED and GREEN, the system 
may be recovering from power drop out. Wait three hours to allow it 
to recool. When the LEDs display GREEN, listen to the system 
again for normal vibration, and sound level. 

� Check and/or clean the air filter. 
  
Cause 13.2 Other. 
  

Solution 13.2 Call the CS-Hotline. 
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Chapter 7  Periodic Visual Inspection 

 
 
 
Visual Inspection Recommendations 
 
The SL Rx cryogenic cooling system is sealed and the electronic circuits are solid state, 
therefore, no maintenance is required. However, the following periodic visual inspection steps 
are suggested. The frequency of inspections depends on the installation site conditions.  
 
� Look for loose electrical connections and loose components on rear panel of SL Rx. 
� Look for frayed input power wires. 
� Look for damaged RF cables. 
� Check the front panel LEDs: 

o In SuperLink mode (Regulate state), the STATUS LED will be steady GREEN 
and the BYPASS LED will be off. 

o In Fault mode, the STATUS LED will be off and the BYPASS LED will be 
RED.  

o In Forced Bypass mode, the LEDs flash GREEN or RED based on the state of the 
system.  

o If the LED displays RED or flashes GREEN and/or RED, see Chapter 6, 
“Troubleshooting Tips” to resolve the problem. 

� Check that the mounting hardware is tight and the SL Rx is securely mounted.  
� Check that ventilation spaces in front and back of the SL Rx are clear.  
� Feel for cooling air exiting the rear of the chassis. The fans run continuously and a steady 

flow of air should be evident. 
� There is a single pop-out air filter mounted on the front panel that may be removed for 

inspection. Recommendations for cleaning the air filter follow in the next section.  
 
 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 53



Cleaning the Air Filter 
 
On an annual basis, inspect the air filter for dust and dirt accumulation that would impede the 
flow of air throughout the SL Rx. In some cases, the frequency of cleaning the air filter depends 
on the air quality of the site. Follow these instructions to clean the air filter periodically. 
 

 

Air Filter

Figure 18. Air Filter Location 
 

1. Located on the SL Rx front panel is a single pop-out air filter. Pull the air filter retainer 
towards you to remove the retainer. 

 

 

Retainer

Figure 19. Removing the Air Filter Retainer 
 

2. Place the retainer aside, and remove the filter. Clean the filter with mil
and dry thoroughly. 
 

3. When the filter is dry, place the filter over the fan, and snap the retaine
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Appendix A  Using the System Status Portal  

 
 
 
Overview 
 
Included in the SL Rx package is the STI CD that contains the System Status Portal, and other 
resources required to run the program. Proper installation of the program will ensure 
communication between the SL Rx and the program on your PC. To install the System Status 
Portal, see Chapter 5, “Installing the SuperLink Rx” or review the ReadMe.html file on the  
STI CD. 
 
The STI CD contains the following items: 
 
� Application folder:  Contains the System Status Portal. 
� JavaRE folder:  Contains the Java Runtime Environment required to support the System 

Status Portal. 
� Manual folder:  Contains the Operation and Installation manuals in Adobe Acrobat PDF, 

Appendix C in Microsoft® Excel, and the Adobe Acrobat Reader. 
� ReadMe.html:  Provides instructions to install the required programs on your PC. 
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System Status Portal Interface 
 
The System Status Portal provides a user-friendly interface to observe the operating parameters 
of the SL Rx. Explained in this section are the various buttons, menus, and fields to view the 
information you need to troubleshoot or verify proper operation of the system.  
 
Main Screen Buttons 
 
On the main screen of the System Status Portal, you will find two buttons at the bottom of the 
window. These buttons are shortcuts to menu items that are most commonly used. 
 

 
 

� Communicate with Unit 
Opens a Comm Port (typically COM1) connection to establish communication with the 
SL Rx. Select the correct Comm Port to connect to the SL Rx. This button is the same as 
File > New. 

 

� View a Unit Record 
Displays the Open dialog box, allowing you to choose an existing XML data file. This 
button is the same as File > Open. 
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Menu Bar 
 
File Menu 
 

 
 

� New… 
Opens a Comm Port connection to establish communication with the SL Rx. The System 
Status Portal lists the available Comm Ports on your PC. Select a Comm Port, then click 
OK to connect. You can also click Communicate with Unit on the main screen to open 
a file. 

 

 The following events open an error dialog box: 
 

o When a Comm Port cannot be found. 
o When the System Status Portal cannot talk to the SL Rx. 

 

 If you find an error, review Chapter 6, “Troubleshooting Tips” to troubleshoot the  
 System Status Portal, or call the CS-Hotline. 
 

� Open… 
Displays the Open dialog box, allowing you to choose an existing XML data file. You 
can also click View a Unit Record on the main screen to open a file. 

  

� Close 
Closes the current session without saving, but does not exit the System Status Portal. 

 

� Save 
Updates all the data records in the System Status Portal before saving them. The File 
Save dialog box opens if the data has not been previously saved. If you previously saved 
a file, the most recent data overwrites the previously saved file. 

 

� Save As… 
Opens the File Save As dialog box, allowing you to change the filename and destination 
if you do not want to overwrite previous results. 

 

� Print 
Prints the screen you are currently viewing. 

 

� Exit 
Closes the current session and exits the System Status Portal without saving. 
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Edit Menu 
 

 
 
The Edit menu is available when you have established a connection with the SL Rx or use  
File > Open. This menu allows you to copy information to the Windows clipboard, and paste the 
information to another program such as Microsoft® Word, Notepad, or WordPad. 
 

� Copy 
Copies text from a current tab to the Windows clipboard. You can paste the information 
to another program such as Microsoft® Word, Notepad, or WordPad. 

 

� Password… 
Opens the Logon Information dialog box to enter a valid password to change or clear 
values in the Set Points and Fault Records. 
 

 
The Password feature is for STI Customer Service only.  

 
View Menu 
 

 
 
The View menu allows you to review information about the operation, fault records, and values 
of the SL Rx. 
 

� Status 
Displays the operating status of the SL Rx. See the “Status View” section on page 59 for 
more information. 

 

� Fault Records 
Displays the status of the faults, showing the first and last occurrence. Only STI can clear 
the faults in this view. See the “Fault Records View” section on page 65 for more 
information. 

 

 
Clearing faults in this view is for STI Customer Service use only. 

 

� Set Points 
Displays the values that configure the operation of the SL Rx and debugging information.  
 

 
Changing values in this view is for STI Customer Service use only. 
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Help Menu 
 

 
 

The Help menu contains information about the System Status Portal and how to contact STI 
Customer Service. 
 

� Support… 
Opens the dialog box containing the CS-Hotline information. 

 

� About… 
Opens the dialog box containing the version number and the date the System Status 
Portal was built. 
 

Status View 
 
The Status View displays the operating status of the system. 
 
Time Tab 
 
The Time tab displays the run and accumulated operating times in hours. 
 

 
 

� Runtime since Powerup 
Displays the time the system has been running since power was last applied to the 
system. 

 

� System Accumulated 
Displays the total accumulated time the system has been powered on. 
 

� Cooler Accumulated 
Displays the total accumulated time the cooler has been powered on. 
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LED Tab 
 
The LED tab displays the state of the LEDs on the system. 
 

 
 

� Status LED 
 

 STATUS LED turned on (GREEN). 
 

 STATUS LED turned off. 
 

� Bypass LED 
 

 BYPASS LED turned on (RED). 
 

 BYPASS LED turned off. 
 

 
Relay Tab 
 
The Relay tab displays the state of the relays or power to the LNAs. 
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� Bypass Relay 
 

 Bypass Relay is on. 
 

 Bypass Relay is off. 
 

� Forced Bypass 
 

 Forced Bypass is on. 
 

 Forced Bypass is off. 
 

� LNA Power 
 

 LNA Power is on. 
 

 LNA Power is off. 

 
System Tab 
 
The System tab shows the operating status of the SL Rx features, control loops, and operating 
limits. 
 

 
 

� LNA Power On 
 

 LNA power turned on. 
 

 LNA power turned off. 
 

� Power/Current Loop Regulating 
 

 Power or current loop regulates within tolerance. 
 

 Power or current loop is not regulating within tolerance. 
 

� Power Loop Active 
 

 Power loop is the active loop. 
 

 Current loop is the active loop. 
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� Power Duty Limit Exceeded 
 

 Power duty cycle has exceeded the maximum limit. 
 

 Power duty cycle has not exceeded the maximum limit. 
 

� Power Drive Limit Foldback 
 

 Power maximum drive level is folding back on a limit. 
 

 Power maximum drive level is off the cooldown table. 
 

� Auto Frequency Adjust 
 

 SL Rx automatically adjusts the operating cooler drive frequency to minimize 
vibration. 
 

 SL Rx operating frequency remains constant. 
 

� Temperature Loop Regulating 
 

 Temperature loop regulates within tolerance. 
 

 Temperature loop is not regulating within tolerance. 
 

� Cold Stage narrow range temperature out of bounds 
 

 Cold Stage narrow range temperature is out of normal operating bounds. 
 

 Cold Stage narrow range temperature is within normal operating bounds. 
 

� Cold Stage wide range temperature out of bounds 
 

 Cold Stage wide range temperature is out of normal operating bounds. 
 

 Cold Stage wide range temperature is within normal operating bounds. 
 

� Cooler Rejection temperature out of bounds 
 

 Cooler Rejection temperature is out of normal operating bounds. 
 

 Cooler Rejection temperature is within normal operating bounds. 
 

� Ambient temperature out of bounds 
 

 Ambient temperature is out of normal operating bounds. 
 

 Ambient temperature is within normal operating bounds. 
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Measure Tab 
 
The Measure tab displays either the current or previously saved system temperature, cooler 
drive, and LNA measurements. 
 

 
 

� Cold Stage narrow range temperature 
Displays the Cold Stage narrow range temperature measured in K. 

 

� Cold Stage wide range temperature 
Displays the Cold Stage wide range temperature measured in K. 

 

� Cooler Rejection temperature 
D
  

isplays the Cooler Rejection temperature measured in °C. 

� Ambient temperature 
Displays the Ambient temperature measured in °C. 

 

� Input Voltage 
Displays the Input Voltage measured in VDC. 

 

� Cooler Power 
Displays the Cooler motor drive real Power measured in W. 

 

� Cooler Power Error 
Displays the Cooler motor drive real Power error measured in W. 

 

� Cooler Voltage Real 
Displays the Cooler motor drive real voltage measured in VRMS. 

 

� Cooler Current Real 
Displays the Cooler motor drive real current measured in ARMS. 

 

� Cooler Current Phase 
Displays the Cooler motor drive current phase referenced to voltage, in degrees. 
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� Cooler Impedance 
Displays the Cooler motor drive impedance measured in ohms. 

 

� Cooler Current RMS 
Displays the Cooler motor drive total current measurement in ARMS. 

 

� PWM Drive 
Displays the Cooler motor drive pulse width modulation measured in %. 

 

� PWM Feedforward 
Displays the Cooler motor drive feedforward gain measured in %. 

 

� PWM Frequency 
Displays the Cooler motor drive sine wave frequency measured in Hz. 

 

� Internal LNA Current 
Displays the Internal LNA Current measured in mA. 

 

� External Current 
Displays the External LNA Current measured in mA. 

 
State Tab 
 
The State tab indicates the state machine status of the SL Rx. 
 

 
 

� State Machine Mode 
Displays the operating mode of the SL Rx. In Automatic mode, the system will  
automatically sequence through the states. In Manual mode, the operator manually  
changes states by selecting the state. 
 

� State Machine State 
Displays the operating state of the SL Rx. See Table 7 for more information about  
the states.  
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Fault Records View 
 
The Fault Records View displays the status of the faults, showing the first and last occurrence. 
If you find any active faults, call the CS-Hotline. 
 

 
 
Status Tab 
 
The Status tab displays the status of each fault: 
 

 Record 
The fault was recorded for either the first or last occurrence. 
 

 Active 
The fault is currently active. 
 

 Clear 
For STI Customer Service only. Call the CS-Hotline to clear faults that appear in 
this tab. 
 

If your system experiences a fault, review Chapter 6, “Troubleshooting Tips” to troubleshoot 
your system or call the CS-Hotline for assistance. 
 

� PM-Power Loop regulation fault? 
A Power or Current Loop out of regulation fault was recorded. 

 

� Tcsw-Cold Stage wide range temperature out of operating range fault? 
A Cold Stage wide range temperature out of bounds fault was recorded. 
 

� Trej-Cooler Rejection temperature exceeds operating range fault? 
A Cooler rejection temperature out of bounds fault was recorded. 

 

� Tcsn-Temperature Loop regulation fault? 
A Temperature Loop out of regulation fault was recorded. 
 
 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 65



� Ilna-LNA current exceeds operating range fault? 
A LNA current out of bounds fault was recorded. The reason for the fault may be due to 
the internal or external LNA. 

 

� Vin-Input Voltage exceeds operating range fault? 
An Input Voltage out of bounds fault was recorded. 
 

� Duty-Duty Cycle exceeds operating range fault? 
The Duty Cycle exceeded the maximum fault was recorded. This does not affect the 
active fault indication. 

 
PM First Tab 
 

 
Since the tabs in the Fault Records View contain the same fields, only the PM First 
and Last tabs are described. The following tabs will only describe the type of faults 
that occurred.  

 
The PM First tab shows the fault for the first occurrence of a power loop out of regulation or 
cooler impedance fault. 
 

 
 

� Fault Type 
Two types of faults that trigger this record: a power loop out of regulation fault or cooler 
motor impedance out of bounds fault. 

 

� Operating State 
Displays the state machine state when this fault occurred. The states are defined in  
Table 7. 

  

� Fault Count 
Displays the number of times this fault record was written. The first occurrence will 
always be one if the fault occurred. The last occurrence will be one if the fault occurred 
twice and the number of times the fault occurred less one subsequently. 
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� Run Time 
Displays the time since the system was last powered up in Hours:Minutes:Seconds when 
this fault occurred. 
 

� System Accumulated Time 
Displays the number of hours the system had operated when this fault occurred. 

 

� Ambient temperature 
Displays the ambient temperature in ºC when this fault occurred. 

 

� Cooler Rejection temperature 
Displays the cooler rejection temperature in ºC when this fault occurred. 

 

� Cold Stage wide range temperature 
Displays the cold stage wide range temperature in K when this fault occurred. 

 

� Cold Stage narrow range temperature 
Displays the cold stage narrow range temperature in K when this fault occurred. 

 

� Input voltage 
Displays the input voltage in Vdc when this fault occurred. 

 

� Cooler voltage 
Displays the cooler motor voltage in real part Vrms when this fault occurred. 

 

� Cooler current 
Displays the cooler motor current in real part Arms when this fault occurred. 

 

� LNA current 
Displays the LNA current in mAdc when this fault occurred. If an LNA fault occurred, it 
is either an internal or external LNA fault current. Otherwise, the fault is an internal LNA 
current. 

 

 
For the Ilna First and Last tabs only. The LNA current displays the LNA 
current in mAdc when this fault occurred. If an LNA fault occurred, it is either 
an internal or external LNA fault current, depending on whether the fault was an 
internal or external LNA fault. 

 
 

 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 67



PM Last Tab 
 
The PM Last tab shows the last occurrence of a power loop out of regulation or cooler 
impedance fault. 
 

 
 
Tcsw First /Tcsw Last Tabs 
 
The Tcsw First/Tcsw Last tabs show the first and last occurrence of a cold stage wide range 
temperature out of bounds fault. 
 
Trej First/Trej Last Tabs 
 
The Trej First/Trej Last tabs show the first occurrence of a cooler rejection temperature out of 
bounds fault. 
 
Tcsn First/Tcsn Last Tabs 
 
The Tcsn First/Tcsn Last tabs show the first occurrence of a temperature loop out of regulation 
fault. 
 
Ilna First/Ilna Last Tabs 
 
The Ilna First/Ilna Last tabs show the first occurrence of either an internal or external LNA 
current out of bounds fault. 
 
Vin First/Vin Last Tabs 
 
The Vin First/Vin Last tabs show the first occurrence of an input voltage out of bounds fault. 
 
Duty First/Duty Last Tabs 
 
The Duty First/Duty Last tabs show the first occurrence of a duty cycle exceeded the 
maximum fault. 
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Appendix B  SuperLink Rx Specifications 

 
 
 
Specifications provided for the SL Rx consist of power requirements, physical characteristics, 
and environmental limitations. 
 
For RF performance specifications, see the data sheets for your model. 
 

Table 8. SuperLink Rx Specifications 

Item Characteristic 
Power Requirements 

Input Power Voltage (+27V Nominal) 22.5 to 30 VDC input power 
Input Power Interface  Screw Terminal Block 
Fuse 10A Fast-Blow 
Maximum Input Power at 0 to 50oC Ambient 
Temperature 

 

195 Watts Maximum (at cooldown only) 

Steady-State Input Power at 23oC Ambient 
Temperature 2-Pak System 

 

70 Watts Typical 

Steady-State Input Power at 23oC Ambient 
Temperature 6-Pak System 

 

80 Watts Typical 

Dimensions 
2-Pak System 
6-Pak System 

  

7 inches (H) x 8.4 inches (W) x 23 inches (D) 

SL Rx Weight (excluding Rack Mount Brackets) 
2-Pak System 32.5 lbs 
6-Pak System 34 lbs 

SL Rx Weight (with Overlay model, excluding Rack Mount Brackets) 
2-Pak System 34 lbs 
6-Pak System 35.5 lbs 

Rack Mount Brackets Weight 
19-inch Rack Mount Brackets (pair) 3 lbs 
23-inch Rack Mount Brackets (pair) 4 lbs 

Environmental 
Operating Temperature 0oC to +50oC 
Operating Humidity 5% to 85% RH at 31oC 
Operating Altitude Sea level to 10,000 feet above sea level 
Storage Temperature (Non-Operating) -40oC to +70oC 
Storage Humidity (Non-Operating) 10% to 95% RH non-condensing at 40oC 
Storage Altitude (Non-Operating) Sea level up to 45,000 feet 
Electrostatic Sensitive Devices that require 
Electrostatic Discharge Protection 

The SL Rx contains components that are subject to 
damage from electrostatic discharge (ESD). Take 
precautionary measures when handling components 
mounted at the rear of the system. 
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Appendix C  Receive Path Gain/Loss Calculator 

  
 

For your convenience, this record is also available as a Microsoft® Excel file located in the 
SuperLink Rx Operation and Installation Manual folder on the STI CD. 
 

Standard Model 
 

Reference Measured:  Frequency = _______________     Power Level = _______________ 
 

Mode Receive Path 
Number 

Signal Generator Frequency 
Power Level  (-50 dBm nominal) 

Measured Output 
Level 

Gain/Loss Calculation 
 

Example 
Bypass Example -50.5 dBm -51.0 dBm -0.5 dB 
SL Rx Example -50.5 dBm -37.3 dBm +13.2 dB 
Bypass 1    
SL Rx 1    
Bypass 2    
SL Rx 2    
Bypass 3    
SL Rx 3    
Bypass 4    
SL Rx 4    
Bypass 5    
SL Rx 5    
Bypass 6    
SL Rx 6    
 

SL Rx with Overlay Model 
 

Reference Measured:  Frequency = _______________     Power Level = _______________ 
 

Mode Receive Path 
Number 

Signal Generator Frequency 
Power Level  (-50 dBm nominal) 

Measured Output 
Level 

Gain/Loss Calculation 
 

Example 
Bypass Example -50.5 dBm -54.1 dBm -3.6 dB 
SL Rx A Example -50.5 dBm -41.8 dBm +8.7 dB 
SL Rx B Example -50.5 dBm -41.1 dBm +9.4 dB 
Bypass 1    
SL Rx 1A    
SL Rx 1B    
Bypass 2    
SL Rx 2A    
SL Rx 2B    
Bypass 3    
SL Rx 3A    
SL Rx 3B    
Bypass 4    
SL Rx 4A    
SL Rx 4B    
Bypass 5    
SL Rx 5A    
SL Rx 5B    
Bypass 6    
SL Rx 6A    
SL Rx 6B    
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Index 

 
F A 

Fault Records view, 65 air filter 
Ilna First tab, 68 cleaning, 54 
Ilna Last tab, 68 alarm relay 
PM First tab, 66 connection, 32 
PM Last tab, 68 states, 45 
Status tab, 65 test, 37 
Tcsn First tab, 68 

B Tcsn Last tab, 68 
Tcsw First tab, 68 Bypass LED, 10 
Tcsw Last tab, 68 Bypass state, 34 
Trej First tab, 68 
Trej Last tab, 68 C 
Vin First tab, 68 

Cascade configuration, 6 Vin Last tab, 68 
2-Pak overlay rear panel, 12 filter. See air filter. 
2-Pak rear panel, 11 Forced Bypass button, 10 
6-Pak overlay rear panel, 13 Forced Bypass state, 34 
6-Pak rear panel, 12 front panel indicators and controls, 10 
cabling diagram, 44 functional checks, 35 
gain test setup, 41 alarm relay connection, 32 
RF connections, 42 alarm relay test, 37 
RF connections for overlay, 43 console connection, 35 

caution symbol, 3 receive path gain test, 39 
chassis ground installation, 31 test generator calibration data, 38 
console connection and operation, 35 
Cooldown state, 34 G 
cryogenic cooling, 8 

gain test setup, 41 Customer Service Hotline (CS-Hotline), 3 
general safety 

cautions, 3 D 
notes, 3 

Digital Signal Processor (DSP), 8 warnings, 3 

E H 
Electrostatic Discharge (ESD), 3 hand tools required, 20 
equipment configurations, 5 
equipment specifications, 69 I 
equipment supplied, 15 

Initial state, 34 ESD. See electrostatic discharge. 
inspection procedures, 53 
installation 
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receive path gain/loss calculator, 71 alarm relay, 32 
receive path gain/loss calculator for overlay, 

71 
chassis ground, 31 
internal states and status, 34 

Regulate state, 34 Java Runtime Environment, 23 
Return Material Authorization (RMA), 17 materials required, 20 
return shipments, 17 mounting the SL Rx, 30 
RF connections power wire, 31 

Cascade, 42, 43 site requirements, 19 
Overlay, 43 supply and material requirements, 20 

RF signal flow, 7 System Status Portal, 27 
test equipment required, 21 

S troubleshooting, 46 
internal states and status, 34 safety. See general safety. 

Shutdown state, 34 
J STATUS LED, 10 

Status view, 59 Java Runtime Environment, 21 
LED tab, 60 

M Measure tab, 63 
Relay tab, 60 maintenance, 53 
State tab, 64 materials required, 20 
System tab, 61 model number, 13 
Time tab, 59 mounting the SL Rx, 30 

SuperLink mode, 34 
supply and material requirements N 

for installation, 20 
note symbol, 3 System Status Portal 

communication with SuperLink Rx, 55 O Edit menu, 58 
operation troubleshooting, 51 Fault Records view, 65 
overlay model, 6 File menu, 57 

Help menu, 59 
P installation, 27 

interface, 55 packing instructions, 18 
Java Runtime Environment, 21 PC requirements, 21 
main screen buttons, 56 power terminal block, 8 
PC requirements, 21 power wire installation, 31 
Status view, 59 powering up, SuperLink Rx, 33 
using the, 55 
View menu, 58 R 

rack mount bracket installation, 31 T 
rear panel connectors and controls 

technical assistance, 3 2-Pak, 11 
test equipment required, 21 2-Pak overlay, 12 
test generator calibration data, 38 6-Pak, 12 
troubleshooting tips, 45 6-Pak overlay, 13 

installation, 46 receive path gain test, 39 
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operation, 51 

U 
unpacking the SL Rx, 16 

W 
warning symbol, 3 
warranty, 4 

 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 75



 

STI Customer Service Hotline 800.727.3648   SuperLink Rx Operation and Installation Manual 76



 
 
 

SuperLink Rx is a trademark of Superconductor Technologies Inc. (STI).  
All other marks are properties of their respective owners.  
 
Superconductor Technologies Inc (STI), 2002-2004. All Rights Reserved. 
Information in this manual is subject to change without notice. Reproduction, adaptation, or translation 
without prior written permission is prohibited, except as allowed under the copyright laws. 
 
STI part number:  830-0013E. Last updated:  3/5/04. 
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